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 Bu modül, mesleki ve teknik eğitim okul/kurumlarında uygulanan Çerçeve 

Öğretim Programlarında yer alan yeterlikleri kazandırmaya yönelik olarak 

öğrencilere rehberlik etmek amacıyla hazırlanmış bireysel öğrenme 
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AÇIKLAMALAR 
MODÜLÜN KODU 520TC0043 

ALAN Mobilya ve İç Mekân Tasarımı 

DAL / MESLEK Mobilya ve İç Mekân Ressamlığı 

MODÜLÜN ADI Bilgisayarlı Tek Mobilya Çizimi 

MODÜLÜN TANIMI 
Mobilya ve İç Mekân Tasarımı alanında Bilgisayarlı Tek 
Mobilya çizimlerinin yapıldığı ve bilgisayarda tek mobilya 
çizimleri hakkında bilgilerin verildiği öğrenme materyalidir.   

SÜRE 40/32+(40/32) 

ÖN KOŞUL  

YETERLİK Bilgisayarda Tek Mobilya çizimlerini yapabilecektir 

 
MODÜLÜN AMACI 

 

 

 

Genel Amaç 
Öğrenci; 
Öğrenci; gerekli ortam sağladığında bu modülle düzgün, 
ölçüsünde, kurallara uygun olarak grup mobilya çizimi 
yapabilecektir.  

Amaçlar 
1. Bilgisayarda üç boyutlu kuralına uygun resim çerçevesi 

çizebilecektir.  
2. Bilgisayarda üç boyutlu kuralına uygun sehpa 

çizebilecektir.  
3. Bilgisayarda üç boyutlu kuralına uygun televizyon dolabı 

çizebilecektir.  

EĞİTİM 
ÖĞRETİM 

ORTAMLARI 

VE DONANIMLARI 

Ortam: Bilgisayar Labaratuvarı ortamı 
Donanım: Ölçme ve kontrol araç-gereçleri, bilgisayar 
donanımı, projeksiyon veya tepegöz 

ÖLÇME VE 

DEĞERLENDİRME 

Modül içinde yer alan her öğrenme faaliyetinden sonra verilen 
ölçme araçları ile kendinizi değerlendireceksiniz.  
Öğretmen modül sonunda ölçme aracı  (çoktan seçmeli test, 
doğru-yanlış testi, boşluk doldurma, eşleştirme vb.) kullanarak 
modül uygulamaları ile kazandığınız bilgi ve becerileri ölçerek 
sizi değerlendirecektir. 

 
 

 

 

 

 
 

AÇIKLAMALAR 
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GİRİŞ 
 

Sevgili Öğrenci, 
 
Mobilya ve İç Mekân Tasarımı Alanı insanlığın yüz yıllardır ihtiyaç duyduğu, işlevsel 

değerleri ile mekânların kullanışlığını, estetik değeriyle de yaşadığımız ve çalıştığımız 
mekânların sıcak, sevimli ve renkli bir ortam hâline gelmesini sağlar. Bu alan sanatı ve 
tekniği birleştirerek ürünü ortaya çıkarır. Alanda ahşap ve ahşap ürünleriyle birlikte boya, 
vernik, renk, cam, plastik, çelik ve metal gibi gereçler de kullanılmaktadır.  
 

Bu alanın sağladığı istihdam olanakları, mevcut ve potansiyel olarak sahip olduğu 
katma değer yaratma gücüyle, ülkemizin önemli faaliyet sektörlerinden birisidir.  
 

Gelişen sanayi ile beraber gerekli olan imalat resimleri çizim masasından bilgisayar 
ortamına taşınmıştır. Bilgisayarın getirdiği pratiklik geriye dönük esnekliği ile imalat 
resimlerinin çizimi hız kazanmıştır. Tasarım aşamasındaki bir iş parçasının bilgisayar 
ekranında hazırlanması sağlanmaktadır. Böylelikle malzemeden tasarruf sağlanmış; zaman, 
sermaye ve iş gücü kaybı önlenmiş olacaktır. Bu bağlamda modülün bilinmesi sizin için çok 
daha geniş iş imkânları ve kalite olanakları sunmaktadır. Bu sektörün istediği nitelikteki 
teknik eleman ihtiyacını karşılamış olacaksınız.  
 

Bilgisayar destekli çizim ve tasarım programları birçok küçük ve büyük işletme 
tarafından kullanılmaktadır. İşletmelerin taleplerine göre sürekli özellikleri geliştirilmekte ve 
kullanım alanları sürekli artırılmaktadır. Üretilecek mamulün, ham madde aşamasında ilk 
önce bilgisayar ortamında tasarımı yapılacaktır. Buna göre ürün ekranda gösterilip şekli 
incelenmektedir. 
 

Bu modül ile iki boyutlu ve üç boyutlu çizim yapabilecek ve çizim üzerinde 
düzenleme işlemlerini uygulayabileceksiniz. Mobilya ve İç Mekân Tasarımı alanında resmin 
büyük önemi vardır. Yeni tasarımların oluşturulmasında hayal gücünün büyük önemi vardır 
ancak işin uygulanabilir olması için yeteri kadar temel resim bilgisine gereksinim vardır. İşte 
bu modülde mümkün olduğunca temel bilgiler verilmeye çalışılmıştır. Ne kadar çok çizim 
uygulaması yaparsanız bilgi ve becerilerinizin aynı oranda artacağını unutmayınız.  

 

 

 

 

 

GİRİŞ 
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ÖĞRENME FAALİYETİ-1 
Bu modülde resim çerçevesi, sehpa, TV dolabı, izometrik perspektifleri, kesit ve 

detaylarını ölçüsüne ve kurallara uygun olarak bilgisayarda çizimini öğreneceksiniz.  

 

 
 
Bu faaliyette verilen bilgiler doğrultusunda düzgün, ölçüsünde, kurallara uygun bir 

şekilde, resim çerçevesi çizimi yapabileceksiniz. 
 

 

 

 

 Resim çerçevesi çiziminde kesit ve detaya neden ihtiyaç vardır? Araştırınız.  

 Çevrenizde tek mobilya imalatı ve resim çerçevesi üreten işletmeler varsa irtibat 

kurarak görüşlerini alınız.  

 Not aldığınız fikir ve görüşleri arkadaşlarınızla paylaşınız.  

 

1. RESİM ÇERÇEVESİ ÇİZİMİ 
 

1.1.Üç Boyutlu Çizimi 
 

CAD tabanlı programlar ile perspektif çizimi oldukça kolaydır. Programın bize 
sunduğu üç boyutlu çizim ortamıyla perspektifin yüzeyleri üzerinde rahatlıkla çalışabilir ve 
çizdiğimiz cismin herhangi bir yönden görünüşünü alabiliriz. Yine çizdiğimiz cisme 
istediğimiz herhangi bir açıdan bakarak yeni görünümler elde edebiliriz.  
 

Programlar iki boyutlu düzlemde açılır. Eğer üç boyutlu perspektif çizimleri yapmak 
istiyorsak çizim ortamını üç boyutlu “izometrik” düzlem olarak ayarlamamız gerekmektedir. 
İki boyutlu düzlemden üç boyutlu çizim ortamına geçmek için view> menüsünden 3D Views 
açılır kutusuna tıklanır ve açılan yeni menüden SW İsometrik seçeneği tıklanır (Resim 1.1).  
 

AMAÇ 

ÖĞRENME FAALİYETİ–1 
 

ARAŞTIRMA 
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Resim 1.1: İzometrik düzlemin ayarlanmas ı 

Üç boyutlu düzlemde çizim yapmak için koordinat sistemleri kullanır. Çizim XYZ 
koordinatlarında gerçekleştirilir. İzometrik düzlem resimde üç boyutlu bir çıktı vermesine 
rağmen aslında iki boyutlu bir çizimdir. CAD tabanlı programlarda üç boyutlu düzlem daha 
çok katı modelleme yapmak üzere kullanılır. Siz de bu düzlemde katı modelleme ve yüzey 
oluşturma komutlarıyla gerçek cisimler elde edebilirsiniz.  
 

CAD tabanlı programlarda isternirse üç boyutlu düzlemde çizdiğiniz perspektiflerin 
görünüşlerini de otomatik olarak oluşturabilir. Bunun için çizim ortamını görünüş resimleri 
de gösterecek şekilde ayarlamanız gerekmektedir. (Resim 1.2, Resim 1.3 ve Resim 1.4).  

 

 

Resim 1.2: Ekranın görünüşleri de gösterebilmesi için ayarlanması 
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Resim 1.3: 3D Çizim ekranının düzenlenmesi 

 

Resim 1.4: 3D Çizim ekranının düzenlenmesi 

Çizim komutlarını uygulamaya başlamadan önce resim 1.3 ve resim 1.4’te gösterildiği 
gibi çizim ekranımızı 3D düzlem olarak düzenleyelim. Ardından aşağıdaki çizim adımlarını 
komut satırı aracılığı ile uygulayalım. Koordinat düzleminin şekil 3’te gösterildiği gibi 
olduğuna dikkat ediniz. Komut satırına öncelikle X ve Y değeri girilir. Her eksen için girilen 
değer virgülle ayrılır (0,50 gibi). Eğer çizgi yönü koordinat düzleminin tersi yönde ise 
değerler eksi olarak girilir (0,-50 gibi.). (Resim 1.5). 
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Resim 1.5: Koordinat düzlemi  

Çizime başlamadan aşağıda şekli verilen resim çerçevesini inceleyiniz.(Şekil 1.1) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Şekil 1.1: Resim çerçevesi izometrik perspektifi  

Yapacağımız resim çerçevesi açık zıvanalı, 2/3 lambalı olarak birleştirilmiştir. Buna 
göre ilk olarak sol dikmeyi şu şekilde oluşturabiliriz.  

Karakteristik özellik sol yan görünüşte olduğu için görünüm alanlarından left 
bölmünde çalışmak bize kolaylık sağlayacaktır. Buna göre; 
 
Polyline (pl) 
 

Command: pl 
PLINE 
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Specify start point: 0,0 
Current line-width is 0.0000 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @0,50 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0.7,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,-5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0.7,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0.7,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,-50 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-0.7,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-0.7,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,-5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-0.7,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 
 

Yukarıdaki komutları sırası ile uyguladığımızda elde edeceğimiz görüntü alttaki gibi 
olacaktır. (Şekil 1.2) 

 

Şekil 1.2: Polyline komutu ile resim çerçevesi yan parçasının 2 boyutlu çizimi  

Şu anda resim çerçevesinin soldaki dikme parçası 2 boyutlu çizilmiş durumdadır. 6 cm 
kalınlığında yükseltilmesi gerekmektedir.  
 

Katı model oluşturmak için PLINE nesnelerden yararlanılır. P line  nesne kapalı bir 
alan oluşturmalıdır. Komutlara üst menüden Draw> Solids ile ya da Solids araç çubuğunda 
yer alan ve aşağıda işaretli olan araçlarla ulaşılır. (Resim 1.6) 
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Resim 1.6: Solids menüsü extrude komutu  

Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir: 
 

Command: extrude (ext) 
Current wire frame density:  ISOLINES=4   (Burası bilgi içindir, herhangi bir değer 
girilmez.) 
Select objects: 1 found  (Yükseltilecek cisimlerin seçimi. Burada left te çizilmiş görünüş 
seçilir.) 
Select objects: 
Specify height of extrusion or [Path]: 6   (Nesneleri yükseltme değeri)  
Specify angle of taper for extrusion <0>:   (Yükseltilirken nesneye uygulanacak konikleşme 
açı değeri) 

(Dilersek istediğimiz görünüşü zoom komutlarını kullanarak büyütüp-küçültebiliriz.) 
Yukarıdaki komutlar girildiğinde alttaki şekil oluşacaktır. (Şekil 1.3) 

 

 

Şekil 1.3: Resim çerçevesi yan parçasının extrude komutu ile yükseltilmesi 

Parçamıza lamba açmak için 50 boyunda, 1.4 genişliğinde, 1 kalınlığında katı model 
çizip şeklimizden çıkarmamız gerekir. Bunun için; 
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Katı model oluşturmak için PLINE nesnelerden yararlanılır. P line nesne kapalı bir 
alan oluşturmalıdır. Komutlara üst menüden Draw> Solids>Box ile ya da Solids araç 
çubuğunda yer alan ve aşağıda işaretli olan araçlarla ulaşılır. (Resim 1.7) 

 

Resim 1.7: Solids menüsü box komutu  

SW Isometric View bölümünde çalışmak işimizi kolaylaştıracaktır. Seçim yapıldıktan 
sonra; 
 
Command: _box 
Specify corner of box or [CEnter] <0,0,0>: 0,0,0 
Specify corner or [Cube/Length]: l 
Specify length: -1 
Specify width: -1.4 
Specify height: 50 

 
Komutları girildiğinde alttaki şekil oluşacaktır. (Şekil 1.4) 

 

 

Şekil 1.4: Resim çerçevesi yan parçasından çıkacak parçanın katı model çizimi  

Şimdi de oluşturduğumuz bu nesneyi ana şekilden çıkaracağız. Bunu çıkarmamız için 
subtract komutunu kullanırız. Komutlara üst menüden Modify>Solids Editing>Subtract ile 
ya da Solids Editing araç çubuğunda yer alan ve aşağıda işaretli olan araçlarla ulaşılır. 
(Resim 1.8) 
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Resim 1.8: Solids editing menüsü subtract komutu  

Subtract bir grup katı modelden, diğer grup katı modeli kullanarak boşluk oluşturmayı 
sağlar. Komut kısa yolu SU’dur. Şu şekilde uygulanır.  
 
Command: _subtract Select solids and regions to subtract from .. 
Select objects: 1 found (Boşluk açılacak katı model(ler)in seçimi (örnekte resim çerçevesi 
yan parçası)) 
Select objects: 
Select solids and regions to subtract .. 
Select objects: 1 found (Boşluk açacak model(ler)in seçimi (örnekte küçük çıkarılacak olan 
parça)) 
Select objects: 
 

Yukarıdaki komutlar uygulandığında şeklimiz şu şekilde görünecektir. (Şekil 1.5) 
 

 

Şekil 1.5: Resim çerçevesi yan görünüşü 3 boyutlu çizimi  

Autocad ekranı tel kafes çizime ayarlı olduğundan dolayı görünmeyen çizgilerin 
gizlenmesine ihtiyaç vardır. Komutlara üst menüden View>Shade>Hidden ile ya da Solids 
araç çubuğunda yer alan ve aşağıda işaretli olan araçlarla ulaşılır. (Resim 1.9) 
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Resim 1.9: Shade menüsü hidden komutu 

Hidden yapılmış resmimiz şu şekilde görünecektir. (Şekil 1.6) 
 

 

Şekil 1.6: Hidden komutu ile görünmeyen çizgilerin gizlenmesi  

Alt parçayı elde etmek için şu yolları izleyebiliriz. Karakteristik özellik üst görünüşte 
olduğu için görünüm alanlarından top bölümünde çalışmak bize kolaylık sağlayacaktır. Buna 
göre; 

 
Command: pl 
PLINE 
Specify start point: -20,-10 
Current line-width is 0.0000 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @35,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,0.7 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-5,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,0.7 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-25,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,-0.7 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-5,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,-0.7 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 
Command: pl 
PLINE 
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Specify start point: -14,-10 
Current line-width is 0.0000 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @23,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,-0.7 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-23,0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @0,0.7 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 

Burada iki farklı yükselti olduğu için iki farklı düzlem oluşturup ayrı ayrı extrude 
vermek gerekir. Yukarıdaki komutlar girildiğinde şeklimiz şu şekilde görünecektir.  (Şekil 
1.7) 

 

 

Şekil 1.7: Alt parçanın polyline komutu ile oluşturulması 

Üst kısımda yer alan düzleme 5, altta yer alan düzleme 6 extrude değeri girilir. Bu 
durumda şeklimiz şu şekilde görünecektir. (Şekil 1.8) 
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Şekil 1.8: Alt parçanın extrude komutu ile yükseltilmesi 

Şimdide ayrı ayrı çizdiğimiz bu şekli birleştirmemiz gerekecektir. Bunun için üst 
menüden Modify>Solids Editing>Union ile ya da Solids Editing araç çubuğunda yer alan ve 
aşağıda işaretli olan araçlarla ulaşılır. (Resim 1.10) 

 

Resim 1.10: Solids editing menüsü union komutu  

Union dilimlenmiş ya da diğer katı model nesneleri birleştirmek / tek parça haline 
getirmek için kullanılan komuttur. Burada nesnelerin birbirine dokunma zorunluluğu yoktur. 
(Yani bu nesneler gözden ırak olsalar da gönülden birbirine bağlıdırlar). Birleştirilen katı 
modeller bir katmanın özelliklerini taşır.  

 
Komut şu şekilde çalıştırılır.  

 
Command: union 
Select objects: 1 found (1. obje seçilir.)  
Select objects: 1 found, 2 total (2. obje seçilir.) 
Select objects: (Enter a basılır.)  
 

Alt parçayı move komutu yardımıyla izometrik düzlemde taşırız. Bu durumda 
resmimiz şu şekilde görünecektir. (Şekil 1.9) 
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Şekil 1.9: Alt parçanın move komutuyla taşınıp yan parçaya kenetlenmesi 

Parçalar simetri olduğu için ön görünüşte mirror komutu yardımıyla sağ yan dikme ve 
üst parça çizilebilir. Mirror komutu uygulandığında şeklimiz şu şekilde görünecektir. 

 

Şekil 1.10: Resim çerçevesi üç boyutlu çizimi  
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1.2.Net Resim Çizimi 
 

Auotcadde herhangi bir resmi Mutlak Koordinat Sistemi (Absolute Coordinates), 
Artışlı Koordinat Sistemi (Relative Coordinates), Kutupsal Koordinat Sistemi (Polar 
Coordinates) ve Dinamik Veri Girişi (Dynamic Input) ile çizebiliriz. 
 

Mutlak Koordinat sisteminde model düzleminde UCS ikonunun (koordinat sisteminin 
orijin noktası) bulduğu yer 0,0 noktasıdır. Bu metot kullanılırken noktanın orijine uzaklığı 
(x,y) verilerek çizim yapılır. X ve Y eksenlerinin gösterdiği yönlerdeki ilerlemeler pozitif (+) 
ilerlemelerdir. Çizilecek olan bir çizgi ise başlangıç ve bitiş noktalarının koordinatları verilir.  

Aşağıda net resmi verilmiş resim çerçevesini inceleyiniz. (Şekil 1.11) 

 

Şekil 1.11: Resim çerçevesi net resmi  

Autocadde çizimler farklı yöntemlerle yapılabilmektedir. Resim çerçevesi net 
resminde mutlak koordinat sistemi yöntemiyle çizim ele alınacaktır.  Bunun için yeni bir 
sayfa açarak gereken katman ayarlarını yaparak işe başlıyoruz. 
 

Çizimize ön görünüşün dış çizgilerini oluşturarak başlayalım. Bunun için komut 
satırına şu değerler girilmelidir; 
Command: l 
LINE Specify first point: 0,0 
Specify next point or [Undo]: 35,0 
Specify next point or [Undo]: 35,50 
Specify next point or [Close/Undo]: 0,50 
Specify next point or [Close/Undo]: 0,0 
Specify next point or [Close/Undo]: 

Bu değerler girildiğinde şeklimiz şu şekilde görünecektir. (Şekil 1.12) 
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Şekil 1.12: Resim çerçevesi ön görünüşünün sınırlarının çizimi  

Şimdide ön görünüşü tamamlamak için şu değerler yazılır;  
 

Command: l 
LINE Specify first point: 6,0 
Specify next point or [Undo]: 6,50 
Specify next point or [Undo]: 
Command: l 
LINE Specify first point: 29,0 
Specify next point or [Undo]: 29,50 
Specify next point or [Undo]: 
Command: l 
LINE Specify first point: 6,6 
Specify next point or [Undo]: 29,6 
Specify next point or [Undo]: 
Command: l 
LINE Specify first point: 6,44 
Specify next point or [Undo]: 29,44 
Specify next point or [Undo]: 
 

Değerleri girildiğinde ön görünüş tamamlanmış olacaktır. (Şekil 1.13) 
 



 

  17 

 

Şekil 1.13: Resim çerçevesinin ön görünüşünün çizimi  

Aynı yöntemle yan görünüş şu şekilde çizilecektir.  
 

Command: l 
LINE Specify first point: 65,0 
Specify next point or [Undo]: 65,50 
Specify next point or [Undo]: 67.1,50 
Specify next point or [Close/Undo]: 67.1,0 
Specify next point or [Close/Undo]: 65,0 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 65.7,0 
Specify next point or [Undo]: 65.7,5 
Specify next point or [Undo]: 66.4,5 
Specify next point or [Close/Undo]: 66.4,0 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 65.7,50 
Specify next point or [Undo]: 65.7,45 
Specify next point or [Undo]: 66.4,45 
Specify next point or [Close/Undo]: 66.4,50 
Specify next point or [Close/Undo]: 
 

Yukarıdaki değerler girildiğinde yan görünüş şu şekilde oluşacaktır. (Şekil 1.14) 
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Şekil 1.14: Resim çerçevesi yan görünüşünün çizimi  

Aynı yöntemle üst görünüş şu şekilde çizilecektir.  
 
Command: l 
LINE Specify first point: 0,-30 
Specify next point or [Undo]: 35,-30 
Specify next point or [Undo]: 35,-32.1 
Specify next point or [Close/Undo]: 0,-32.1 
Specify next point or [Close/Undo]: 0,-30 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 0,-30.7 
Specify next point or [Undo]: 5,-30.7 
Specify next point or [Undo]: 5,-30 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 0,-31.4 
Specify next point or [Undo]: 6,-31.4 
Specify next point or [Undo]: 6,-32.1 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 35,-30.7 
Specify next point or [Undo]: 30,-30.7 
Specify next point or [Undo]: 30,-30 
Specify next point or [Close/Undo]: 
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Command: l 
LINE Specify first point: 35,-31.4 
Specify next point or [Undo]: 29,-31.4 
Specify next point or [Undo]: 29,-32.1 
Specify next point or [Close/Undo]: 
 

Yukarıdaki değerler girildiğinde üst görünüşte çizilmiş ve net resim tamamlanmış 
olacaktır. (Şekil 1.15) 
 

 

Şekil 1.15: Resim çerçevesi üst görünüşünün çizimi  
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1.3.Ölçülendirme 
 

Çizilen resim çerçevesinin ölçülendirilmesi için üst menüden Dimension>Linear ile ya 
da Dimension araç çubuğunda yer alan ve aşağıda işaretli olan araçlarla ulaşılır.  

 

Resim 1.11: Dimension menüsü linear dimension komutu  

Dimlinear doğrusal ölçülendirme komutunun kullanılması, X eksenine paralel iki 
nokta arasındaki mesafeyi ölçülendirmek üzere veya ölçülendirilecek nesne seçildikten sonra 
imleç X yönüne dik olarak hareket ettirildiğinde yatay ölçülendirme üretir.  
 
Command: _dimlinear 
Specify first extension line origin or <select object>: (Yatay çizginin A daki uç noktasını 
seçiniz) 
Specify second extension line origin: (Yatay çizginin B deki uç noktasını seçiniz)  
Specify dimension line location or 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: h 
Specify dimension line location or [Mtext/Text/Angle]: (C deki noktayı seçiniz)  
Dimension text = 35 
 

Yukarıdaki değerler girildiğinde aşağıdaki şekil oluşacaktır. (Şekil 1.16) 
 

 

Şekil 1.16: Resim çerçevesi ölçülendirme alıştırması 
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Diğer ölçülendirilecek alanlarda yapıldığında resim çerçevesinin ölçülendirilmesi 

bitmiş olacaktır. (Şekil 1.17) 

 

Şekil 1.17: Resim çerçevesinin ölçülendirilmesi 
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1.4.Renklendirme ve Desen 
 

AutoCAD ile çizilen 2D ve 3D objeler istenildiğinde değişik renklerde boyanabilir. 
Boyama işlemi için Gradient komutundan yararlanılır. Gradient komutu yüzey tarama 

komutu olan Hatch komutu gibi çalışır. Aslında her iki komutta aynı pencerede çalışır. Her 
iki komutla da cismin yüzeyi kaplanır.  

Çizilen resim çerçevesinin renklendirilmesi için üst menüden Draw>Hatch ile ya da 
Draw araç çubuğunda yer alan ve aşağıda işaretli olan araçlarla ulaşılır. (Resim 1.12) 

 

Resim 1.12: Draw menüsü hatch komutu  

Gradient penceresinde çizdiğiniz cisim için renk seçebilir ya da daha önce seçtiğiniz 
rengi değiştirebilirsiniz. Öncelikle penceredeki elemanları tanıyalım. 

“Colour” kısmından cisim için uygulayacağımız rengi seçiyoruz. “One Colour” 
seçeneği cismimize tek renkli bir geçiş efekti uygular. “One Colour” seçeneği altında 
bulunan açılır kutuya çift tıklayarak ya da renk kutusu yanında bulunan butona tıklayarak 
renk seçimi yapılan pencereyi açabilirsiniz. Açılan pencereden perspektifinizde kullanmak 
istediğiniz bir rengi seçebilirsiniz. Rengi seçtikten sonra “Two Colour” seçeneği altında 
bulunan kaydırma çubuğunu sağa-sola hareket ettirerek renk geçişini ayarlayabilirsiniz. Eğer 
renk geçişi istemiyorsanız kaydırma çubuğunu ortada bırakmalısınız. 

“Two Colour” seçeneği ile cisme iki renkli geçiş efekti uygulayabilirsiniz. Bu 
seçeneğe tıkladığınızda seçeneğin altında bulunan kaydırma barı renk kutucuğuna dönüşür. 
Yine bu renk kutucuğuna çift tıklayarak ya da yanında bulunan butona tıklayarak 
uygulayacağınız ikinci rengi belirleyebilirsiniz.  

Renkler belirlendikten sonra ortadaki önizleme bölümünden ışığın konumu belirlenir 
“Orientation” bölümünden ışığın yönünü ayarlayabilirsiniz. “Angle” Açılır kutusuna 
tıklayarak ışığın konumunu değiştirebilirsiniz.  

Renk ve ışık ayarlamasını yaptıktan sonra belirlediğimiz renkleri cismimiz üzerine 
uygulayabiliriz. Bu işlem iki değişik yolla yapılabilmektedir. Birinc isi bölgesel seçim 
yöntemi, ikincisi çizgisel seçim yöntemidir. Bölgesel seçim işlemi uygulanmak istenirse 
birbirini kesen çizgilerin oluşturduğu kapalı bir alan seçilir. Eğer çizgisel seçim işlemi tercih 
edilirse rengin uygulanacağı alanı sınırlayan çizgiler elle tek tek işaretlenir. Seçilen renk ile 
boyanacak tüm yüzeyler seçildikten sonra “Enter” tuşuna tıklanarak tekrar aynı pencereye 
dönüş yapılır. Son olarak pencerenin altında bulunan “OK” butonuna tıklanarak boyama 
işlemi gerçekleştirilir. (Resim 1.13) 
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Resim 1.13: Boundary hatch and fill diyalog penceresi 

Diyalog penceresi açılıp gerekli ayarlamalar yapıldıktan sonra Pick Points kutucuğu 
işaretlenir. Daha sonra boyanacak alan üzerine tıklanır. Burada sol yan parça örnek olarak 
gösterilmiştir. (Şekil 1.18) 
 



 

  24 

 

Şekil 1.18: Renklendirilecek parçanın seçimi 

Enter’a basıp komut aktif hale getirilip açılan pencerede okey seçeneği işaretlenirse 
şeklimiz aşağıdaki gibi boyanacaktır. (Şekil 1.19) 

 

Şekil 1.19: Seçilen parçanın renklendirilmesi 
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Diğer kısımlar da aynı şekilde renklendirilir. (Şekil 1.20) 

 

 

Şekil 1.20: Resim çerçevesinin renklendirilmesi 

 
Desenlendirmeyi serbest çizgi şeklinde yapabiliriz. Serbest çizgiyi aktif halr 

getirebilmek için; 
 
Command: sketch 
Record increment <1.0000>: 10 (Çizginin kırılma mesafesi) 
Sketch.  Pen eXit Quit Record Erase Connect . <Pen down>  <Pen up> 
69 lines recorded (Fare istenildiği gibi gezdirilir.). 

 
Yukarıdaki yazılanlar uygulandığında şekil aşağıdaki gibi olacaktır. (Şekil 1.21) 
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Şekil 1.21: Resim çerçevesinin renklendirilmesi ve desenlendirilmesi 

Anlam karmaşıklığına yol açmaması için dar alanlarda tarama yapılmaz. Bundan 
dolayı yan ve üst görünüşte taramaya gerek görülmemiştir.  
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1.5.Kesit Yerlerinin Belirlenmesi Ve Çizimi 
 

Çizime başlarken gereken katman ayarları yapılmalıdır. Katman ayarlarına Layers 
menüsünde yer alan Layer Properties Manager diyalog kutusundan ulaşılabilir. (Resim 1.14) 

 

Resim 1.14: Layers menüsü 

Açılan Layer Properties Manager diyalog kutusundan gereken seçimler yapılır.  

 

Resim 1.15: Layer properties manager menüsü  

Kesit yeri belirlenirken işin karakteristik özelliğini en çok anlatan görünüş tercih 
edilmelidir. Kesit görünüş olarak ön, yan ya da üst kesit seçilebilir. Burada yan kesit tercih 
edilmiştir. Yan kesit çiziminde yan görünüş kopyalanıp 20 mm mesafede sağ yanına 
yapıştırılır. (Şekil 1.22) 



 

  28 

 

Şekil 1.22: Yan görünüşün kopyalanması 

Katman ayarlarından kesik çizgi seçimi yapılır.  
 

Command: L 
LINE Specify first point: 17,55 
Specify next point or [Undo]: 17,-5 
Specify next point or [Undo]: 
 

Command: l 
LINE Specify first point: 87.1,45 
Specify next point or [Undo]: 87.8,45 
Specify next point or [Undo]: 
 

LINE Specify first point: 87.1,5 
Specify next point or [Undo]: 87.8,5 
Specify next point or [Undo]: 
 

Command: l 
LINE Specify first point: 88.5,45 
Specify next point or [Undo]: 88.5,5 
Specify next point or [Undo]: 
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Command: l 
LINE Specify first point: 88.5,44 
Specify next point or [Undo]: 89.2,44 
Specify next point or [Undo]: 
 
Command: l 
LINE Specify first point: 88.5,6 
Specify next point or [Undo]: 89.2,6 
Specify next point or [Undo]: 
 

Yukarıdaki komutlar girildiğinde şeklimiz şu şekilde görünecektir. (Şekil 1.23) 

 

 

Şekil 1.23: Yan kesitin çizilmesi 

 
 

 
 

 

 

 



 

  30 

1.6.Detay Yerlerinin Belirlenmesi ve Çizimi 
 

Detay yerinin belirlenmesi eksen çizgisi ile gösterilir ve detay çizilecek kısım daire 
içersine alınır.  

 
Command: circle 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 88,44 
Specify radius of circle or [Diameter] <8.0000>: 8 
 

Yukarıdaki komutlar girildiğinde şeklimiz şu şekilde görünecektir. (Şekil 1.24) 

 

Şekil 1.24: Yan kesitte detay yerinin gösterilmesi 

Katman ayarlarından kalın çizgi seçimi yapılır. 
 
Command: line  
Specify first point: 110,-30 
Specify next point or [Undo]: 110,50 
Specify next point or [Undo]: 131,50 
Specify next point or [Close/Undo]: 131,-30 
Specify next point or [Close/Undo]: 
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Command: l 
LINE Specify first point: 117,50 
Specify next point or [Undo]: 117,0 
Specify next point or [Undo]: 124,0 
Specify next point or [Close/Undo]: 124,50 
Specify next point or [Close/Undo]: 

Yukarıdaki komutlar girildiğinde şeklimiz şu şekilde görünecektir. (Şekil 1.25) 

 

Şekil 1.25: Yan detayın sınır çizgilerinin çizilmesi 

Katman ayarlarından kesik çizgi seçimi yapılır.  
Command: l 
LINE Specify first point: 110,0 
Specify next point or [Undo]: 117,0 
Specify next point or [Undo]: 
 
Command: l 
LINE Specify first point: 124,0 
Specify next point or [Undo]: 124,-30 
Specify next point or [Undo]: 
 
Command: l 
LINE Specify first point: 124,-10 
Specify next point or [Undo]: 131,-10 
Specify next point or [Undo]: 
 

Yukarıdaki komutlar girildiğinde şeklimiz şu şekilde görünecektir. (Şekil 1.26). 
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Şekil 1.26: Yan detayda görünmeyen çizgilerin çizilmesi 

Katman ayarlarından ince çizgi seçimi yapılır. Zıvana belirtilir. 
 
Command: l 
LINE Specify first point: 117,50 
Specify next point or [Undo]: 124,0 
Specify next point or [Undo]: 
 
Command: l 
LINE Specify first point: 117,0 
Specify next point or [Undo]: 124,50 
Specify next point or [Undo]: 
 

Yukarıdaki komutlar girildiğinde şeklimiz şu şekilde görünecektir. (Şekil 1.27) 
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Şekil 1.27: Zıvananın gösterilmesi 

Masif makta taraması hatch komutuyla yapılır. (Şekil 1.28) 

 

Şekil 1.28: Masif makta taraması çizimi 
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Diğer kısımlara serbest el taraması yapılır. Bunun için sketch komutu kullanılır.  (Şekil 
1.29) 

 

Şekil 1.29: Elyaf taraması çizimi 

Kesme işareti koyulup detay adı yazılarak resim bitirilir. (Şekil 1.30) 
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Şekil 1.30: Resim çerçevesi detay res minin çizimi 
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1.7.Montaj Resminin Çizimi 
 

Üç boyutlu çizilmiş resim çerçevesini move komutuyla ayırmak suretiyle  montaj 
resmi gösterilir. (Şekil 1.31) 

 

Şekil 1.31: Montaj resminin çizimi  
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UYGULAMA FAALİYETİ-1 
Resim Çerçevesi net resmi çizimi uygulaması yapınız.  

 

İşlem Basamakları Öneriler 

 Çizeceğiniz parçanın ölçülerine uygun 
gerekli limit ayarlarını yapınız.  

 Çiziminizde kullanacağınız katman 
ayarlarını yapınız.  

 Çiziminizi mutlak koordinat sistemine 
göre oluşturunuz.  

 Limiti A4 kağıt ebatı olan 210-297 
ölçülerinde ayarlayınız.  

 limits└ 
 0,0└  
 210,297└ 

 Çizeceğiniz resim çerçevesini inceleyiniz.  

 

 Resim çerçevesi 35 genişlik ve 50 
uzunluğundadır.  

 Resim çerçevesi 45º gönyeburun 
olarak birleştirilmiştir.  

 Resim çerçevesi ön görünüşü sınırlarını 
çiziniz.  

 
 

 Çizime orjini sıfırlayarak başlayınız.  
 line└ 
 0,0└  
 35,0└ 
 35,50└ 
 0,50└ 
 0,0└  

UYGULAMA FAALİYETİ–1 
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 Çerçeve iç parçasını çiziniz. 

 
 

 Çerçeve iç parçasını oluşturunuz.  
 Line 
 6,6 
 29,6 
 29,44 
 6,44 
 6,6 

 Çerçeveleri 45º gönyeburun çiziniz.  

 
 

 Line 
 0,0 
 6,6 
 Line 
 35,0 
 29,6 
 Line 
 35,50 
 29,44 
 Line 
 0,50 
 6,44 

 Yan görünüşü çiziniz. 

 

 50 cm uzunluğunda 3 cm derinliğinde 
yan görünüşü çiziniz.  

 Çiziminizde dikdörtgen çizme komutu 
olan rectangle komutunu kullanınız.  

 Rectang 
 65,0 
 68,50 
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 Üst görünüşü çiziniz.  

 

 35 cm uzunluğunda 3 cm derinliğinde 
üst görünüşü çiziniz.  

 Çiziminizde dikdörtgen çizme komutu 
olan rectangle komutunu kullanınız.  

 Rectang 
 0,-30 
 35,-33 
 

 Gerekli ölçülendirmeleri yapınız.  

 
 

 Ölçülendirmeyi üst menülerde yer 
alan dimension>quick dimension 
komutuyla yapabilirsiniz.  

 Dimenstyle manager penceresinden 
isterseniz bağlama çizgilerini 
silebilirsiniz. 

 İşin adını ve ölçeğini yazınız. 

 

 

 İşin adını ve ölçeğini resmin sağ alt 
kısmında uygun bir yerine yazınız.  

 Bunun için draw menüsü 
komutlarından multiline text 
komutunu kullanabilirsiniz. 

VE DEĞER 
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KONTROL LİSTESİ 
Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler iç in 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 
değerlendiriniz. 

 

 

 
Değerlendirme Ölçütleri Evet Hayır 

1. Çizeceğiniz parçanın ölçülerine uygun gerekli 
limit ayarlarını yaptınız mı? 

2. Çiziminizde kullanacağınız katman ayarlarını 
yaptınız mı?  

  

3. Çizeceğiniz resim çerçevesini incelediniz mi?    
4. Resim çerçevesi ön görünüşü sınırlarını çizdiniz 

mi? 
  

5. Çerçeve iç parçasını çizdiniz mi?   
6. Çerçeveleri 45º gönyeburun çizdiniz mi?   
7. Yan görünüşü çizdiniz mi?    
8. Üst görünüşü çizdiniz mi?   
9. Gerekli ölçülendirmeleri yaptınız mı?   
10. İşin adını ve ölçeğini yazdınız mı?    

 

 

 
DEĞERLENDİRME 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 
Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 
“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz.    
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ÖLÇME VE DEĞERLENDİRME 
L 
 

 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız.  

 

 
1. (  )   Line komutu çizgi çizmede kullanılır. 

 
2. (  )   Daire çizmek için kullanılan komut rectangle komutudur. 

 
3. (  )   Kesitlerde taramalar kesik çizgiyle çizilmelidir. 

 
4. (  )   Kesitlerde kesilen yüzeyler mutlaka taranmalıdır.  

 
5. (  )   Perspektif çizimlerinde işin adı ve ölçeği uygun bir yere yazılmalıdır.  

 
6. (  )   Net resim çizimlerinde çizime önce kesik çizgilerle başlanmalıdır.  

 
7. (  )   Zıvanalı birleştirme çerçeve köşe birleştirmelerinden biridir.  

 
8. (  )   Sunta resim çerçevesinin yapılmasında kullanılmaz. 

 
9. (  )   Perspektif çizimlerinde masif makta taraması yapılmaz.  

 
10. (  )   Resim çerçevesi resmi dairelerde bulunmazlar. 

 

 

 

 

DEĞERLENDİRME 
Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 
Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz.  

 
 
 

 

 

 

 
 
 
 
 

 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ-2 
 

 

FAALİYETİ - 2  

 
Teknik resim kural ve standartlarına uygun olarak ilan dolabı izometrik perspektifi, 

net resmi, kesit ve detaylarını çizebileceksiniz. 

 

 
 

 İlan Dolabı çiziminde kesit ve detaya neden ihtiyaç vardır? Araştırınız.  

 Çevrenizde tek mobilya imalatı ve ilan dolabı üreten işletmeler varsa irtibat 

kurarak görüşlerini alınız.  

 Not aldığınız fikir ve görüşleri arkadaşlarınızla paylaşınız.  

2. SEHPA ÇİZİMİ 
2.1. Üç Boyutlu Çizimi 
 

Çizime başlamadan aşağıda şekli verilen orta sehpa resmini inceleyiniz. (Şekil 2.1) 

 

AMAÇ 

ÖĞRENME FAALİYETİ–2 
 

ARAŞTIRMA 
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Şekil 2.1: Orta sehpa izometrik pers pektifi 

 
Yukarıda verilen şeklin ayaklarını oluşturarak çizime başlayalım. 

 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 0,0 
Specify corner or [Cube/Length]: l 
Specify length: 4 
Specify width: 4 
Specify height: -40 
Command: 
 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 0,54 
Specify corner or [Cube/Length]: l 
Specify length: 4 
Specify width: -4 
Specify height: -40 
Command: 
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Command: box 
Specify corner of box or [CEnter] <0,0,0>: 54,0 
Specify corner or [Cube/Length]: l 
Specify length: -4 
Specify width: 4 
Specify height: -40 
Command: 
 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 54,54 
Specify corner or [Cube/Length]: l 
Specify length: -4 
Specify width: -4 
Specify height: -40 
Command: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.2) 

 

Şekil 2.2: Ayakların çizimi  

Kayıtların çizimini de şu şekilde yapabiliriz.  
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Command: box 
Specify corner of box or [CEnter] <0,0,0>: 4,0.5 
Specify corner or [Cube/Length]: l 
Specify length: 46 
Specify width: 2 
Specify height: -10 
Command: 
 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 0.5,4 
Specify corner or [Cube/Length]: l 
Specify length: 2 
Specify width: 46 
Specify height: -10 
Command: 
 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 53.5,4 
Specify corner or [Cube/Length]: l 
Specify length: -2 
Specify width: 46 
Specify height: -10 
Command: 
 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 4,53.5 
Specify corner or [Cube/Length]: l 
Specify length: 46 
Specify width: -2 
Specify height: -10 
Command: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.3) 
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Şekil 2.3: Kayıtların çizimi  

 
Üst tabla çizimini de şu şekilde yapabiliriz.  

 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: -3,-3 
Specify corner or [Cube/Length]: l 
Specify length: 60 
Specify width: 60 
Specify height: 2 
Command: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.4) 
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Şekil 2.4: Üst Tablanın çizimi  

 
Şeklimizi izometrik düzlemde görebilmek için üst menülerde yer alan view>3D 

views>SW Isometric seçeneği işaretlenir. (Şekil 2.5) 
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Şekil 2.5: İzometrik düzlemde sehpanın görünümü  

 
Görünmeyen çizgileri gizlemek için de üst menülerde yer alan view>hide seçeneği 

işaretlenir. (Şekil 2.6) 
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Şekil 2.6: Sehpanın üç boyutlu çizimi  
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2.2. Net Resim Çizimi 
 

İlk olarak ön görünüşü oluşturalım. Resim çerçevesinin çiziminde mutlak koordinat 
sistemine göre çizim oluşturulmuştu. Sehpanın çiziminde ise artışlı koordinat sistemine göre 
çizimimizi oluşturacağız. 
 
Command: l 
LINE Specify first point: 0,0 
Specify next point or [Undo]: @60,0 
Specify next point or [Undo]: @0,-2 
Specify next point or [Close/Undo]: @-60,0 
Specify next point or [Close/Undo]: @0,2 
Specify next point or [Close/Undo]: 
Command: 
 
Command: l 
LINE Specify first point: 3,-2 
Specify next point or [Undo]: @0,-40 
Specify next point or [Undo]: @4,0 
Specify next point or [Close/Undo]: @0,40 
Specify next point or [Close/Undo]: 
 
LINE Specify first point: 57,-2 
Specify next point or [Undo]: @0,-40 
Specify next point or [Undo]: @-4,0 
Specify next point or [Close/Undo]: @0,40 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 7,-12 
Specify next point or [Undo]: @46,0 
Specify next point or [Undo]: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.7) 
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Şekil 2.7: Sehpanın ön görünüşünün çizimi  

Şimdide yan görünüşü oluşturalım. 
Command: l 
LINE Specify first point: 90,0 
Specify next point or [Undo]: @0,-2 
Specify next point or [Undo]: @60,0 
Specify next point or [Close/Undo]: @0,2 
Specify next point or [Close/Undo]: @-60,0 
Specify next point or [Close/Undo]: 
 

Command: l 
LINE Specify first point: 93,-2 
Specify next point or [Undo]: @0,-40 
Specify next point or [Undo]: @4,0 
Specify next point or [Close/Undo]: @0,40 
Specify next point or [Close/Undo]: 
 

Command: l 
LINE Specify first point: 147,-2 
Specify next point or [Undo]: @0,-40 
Specify next point or [Undo]: @-4,0 
Specify next point or [Close/Undo]: @0,40 
Specify next point or [Close/Undo]: 
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Command: l 
LINE Specify first point: 97,-12 
Specify next point or [Undo]: @46,0 
Specify next point or [Undo]: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.8) 

 

Şekil 2.8: Sehpanın yan görünüşünün çizimi  

Üst görünüşün oluşturulması şu şekildedir. 
 

Command: l 
LINE Specify first point: 0,-72 
Specify next point or [Undo]: @60,0 
Specify next point or [Undo]: @0,-60 
Specify next point or [Close/Undo]: @-60,0 
Specify next point or [Close/Undo]: @0,60 
Specify next point or [Close/Undo]: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.9) 

 

Şekil 2.9: Sehpanın yan görünüşünün çizimi  
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2.3. Ölçülendirme 
 

Gerekli katman ayarları yapılır. Daha sonra istenirse üst menülerde yer alan 
dimension>quick dimension seçeneği ile çoklu ölçülendirme yapılabilir. (Şekil 2.10) 

 

Şekil 2.10: Sehpanın ölçülendirilmesi 

İstenirse dimension style manager diyalog kutusundan bağlama çizgileri silinebilir.  
(Şekil 2.11) 
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Şekil 2.11: Sehpanın bağlama çizgilerinin silinmesi 
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2.4. Renklendirme ve Desen 
 

Renklendirme için üst menüden Draw>Hatch seçimi yapılır. Buradan gradient seçilir. 
Şekil istenen renkle boyanır. (Şekil 2.12) 

 
Şekil 2.12: Sehpanın renklendirilmesi 

Daha sonra sketch komutu ile tarama işlemine geçilir. (Şekil 2.13) 
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Şekil 2.13: Sehpanın renklendirilmesi ve desenlendirilmesi  
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2.5. Kesit Yerlerinin Belirlenmesi ve Çizimi 
 

Kesit resim olarak ön, yan ya da üst kesit çizimi seçimi yapılabilir. Burada yan kesit 
çizimi ve üst kesit çizimi yapılacaktır.  

İlk olarak net resim üzerinde kesit yerlerinin gösterilmesi için şu komutlar girilir: 
 

Command: l 
LINE Specify first point: 30,5 
Specify next point or [Undo]: @0,-52 
Specify next point or [Undo]: 
Command: 
 

Command: l 
LINE Specify first point: -5,-2 
Specify next point or [Undo]: @70,0 
Specify next point or [Undo]: 
 

Komutları girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. (Şekil 2.14) 

 

Şekil 2.14: Net resim üzerinden kesit yerlerinin gösterilmesi  

Daha sonra aşağıdaki komutlar girilerek yan kesit oluşturulur. 
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Üst tablayı oluşturmak için;  
 

Command: l 
LINE Specify first point: 170,0 
Specify next point or [Undo]: @0,-2 
Specify next point or [Undo]: @60,0 
Specify next point or [Close/Undo]: @0,2 
Specify next point or [Close/Undo]: @-60,0 
Specify next point or [Close/Undo]: 
Komutları girilir.  
 

Soldaki ayağı çizmek için;  
 

Command: l 
LINE Specify first point: 173,-2 
Specify next point or [Undo]: @0,-40 
Specify next point or [Undo]: @4,0 
Specify next point or [Close/Undo]: @0,40 
Specify next point or [Close/Undo]: 
Komutları girilir.  
 

Sağdaki ayağı çizmek için;  
 

Command: l 
LINE Specify first point: 227,-2 
Specify next point or [Undo]: @0,-40 
Specify next point or [Undo]: @-4,0 
Specify next point or [Close/Undo]: @0,40 
Specify next point or [Close/Undo]: 
Komutları girilir.  
 

Kayıtı çizmek için; 
 

Command: l 
LINE Specify first point: 177,-12 
Specify next point or [Undo]: @46,0 
Specify next point or [Undo]: 
Komutları girilir.  
 

Sol ayaktaki kayıtı çizmek için; 
 

Command: l 
LINE Specify first point: 173.5,-2 
Specify next point or [Undo]: @0,-10 
Specify next point or [Undo]: @2.1,0 
Specify next point or [Close/Undo]: @0,10 
Specify next point or [Close/Undo]: 
 

Komutları girilir.  
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Sağ ayaktaki kayıtı çizmek için;  
 

Command: l 
LINE Specify first point: 226.5,-2 
Specify next point or [Undo]: @0,-10 
Specify next point or [Undo]: @-2.1,0 
Specify next point or [Close/Undo]: @0,10 
Specify next point or [Close/Undo]: 
Komutları girilir.  
 

Soldaki köşe takozunu çizmek için;  
 

Command: l 
LINE Specify first point: 175.6,-5 
Specify next point or [Undo]: @7,0 
Specify next point or [Undo]: @0,3 
Specify next point or [Close/Undo]: 
Komutları girilir.  
 

Sağdaki köşe takozunu çizmek için;  
 

Command: l 
LINE Specify first point: 224.4,-5 
Specify next point or [Undo]: @-7,0 
Specify next point or [Undo]: @0,3 
Specify next point or [Close/Undo]: 
Komutları girilir.  
 

Daha sonra hatch komutu yardımıyla kesilen kısımlar taranır.  (Şekil 2.15) 
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Şekil 2.15: Yan kesitin çizilmesi  

Üst kesit çizimi yapılır. Ayaklar doğrusal düzlem oldukları için rectangle (dikdörtgen 
çizme) komutu işimizi kolaylaştıracaktır.  

 
Ayakların çizimi şu şekilde yapılacaktır.  

 
Sol üstteki ayağı çizmek için;  

 
Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 3,-150 
Specify other corner point or [Dimensions]: @4,-4 
 

Sağ üstteki ayağı çizmek için;  
 
Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:  
57,-150 
Specify other corner point or [Dimensions]: @-4,-4 
 

Sol alttaki ayağı çizmek için; 
 
Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 3,-204 
Specify other corner point or [Dimensions]: @4,4 
 

Sağ alttaki ayağı çizmek için;  
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Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:  
57,-204 
Specify other corner point or [Dimensions]: @-4,4 
 

Kayıtların çizimi de şu şekilde olacaktır.  
Soldaki kayıtı çizmek için; 

 

Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:  
3.5,-154 
Specify other corner point or [Dimensions]: @2.1,-46 
 

Sağdaki kayıtı çizmek için;  
 

Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:  
56.5,-154 
Specify other corner point or [Dimensions]: @-2.1,-46 
 

Üstteki kayıtı çizmek için; 
 

Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:  
7,-150.5 
Specify other corner point or [Dimensions]: @46,-2.1 
 

Alttaki kayıtı çizmek için;  
 

Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:  
7,-203.5 
Specify other corner point or [Dimensions]: @46,2.1 
 

Köşe takozlarını çizmek içinde şu komutlar girilir. 
Sol üstteki köşe takozunu çizmek için;  

 

Command: l 
LINE Specify first point: 5.6,-159.6 
Specify next point or [Undo]: @7,7 
Specify next point or [Undo]: 
 

Sağ üstteki köşe takozunu çizmek için;  
 

Command: l 
LINE Specify first point: 54.4,-159.6 
Specify next point or [Undo]: @-7,7 
Specify next point or [Undo]: 
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Sol alttaki köşe takozunu çizmek için;  
 
Command: l 
LINE Specify first point: 5.6,-194.4 
Specify next point or [Undo]: @7,-7 
Specify next point or [Undo]: 
 

Sağ alttaki köşe takozunu çizmek için;  
 
Command: l 
LINE Specify first point: 54.4,-194.4 
Specify next point or [Undo]: @-7,-7 
Specify next point or [Undo]: 
 

Yukarıda yazılan komutlar girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. 
 

 

Şekil 2.16: Üst kesitin çizilmesi  
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2.6. Detay Yerlerinin Belirlenmesi ve Çizimi 
 

Yan kesitte detay yerinin belirlenmesi için;  
 

Command: circle 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 177,-3 
Specify radius of circle or [Diameter] <11.0000>: 11 
 

Üst kesitte detay yerinin belirlenmesi için;  
 

Command: circle 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 7,-154 
Specify radius of circle or [Diameter] <11.0000>: 11 
 

Yukarıda yazılan komutlar girildiğinde şu şekilde bir görüntü ortaya çıkacaktır.  

 

Şekil 2.17: Kesit üzerinden detay yerlerinin gösterilmesi  

Burada yan detay ve üst detay yeri gösterilmiştir ancak yalnızca yan detay çizimi 
yapılacaktır. Üst detay çizimi uygulama faaliyetinde gösterilecektir. 
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Üst tablayı çizmek için; 
 

Command: l 
LINE Specify first point: 0,0 
Specify next point or [Undo]: @0,18 
Specify next point or [Undo]: @150,0 
Specify next point or [Close/Undo]: 
 

Command: l 
LINE Specify first point: 0,0 
Specify next point or [Undo]: @150,0 
Specify next point or [Undo]: 
 

Ayağın soldaki sınır çizgisi için;  
 

Command: l 
LINE Specify first point: 30,0 
Specify next point or [Undo]: @0,-120 
Specify next point or [Undo]: 
 

Kayıt çizimi için; 
 

LINE Specify first point: 35,0 
Specify next point or [Undo]: @0,-100 
Specify next point or [Undo]: @21,0 
Specify next point or [Close/Undo]: @0,100 
Specify next point or [Close/Undo]: 
 

Köşe takozunu çizmek için;  
 

Command: l 
LINE Specify first point: 56,-30 
Specify next point or [Undo]: @70,0 
Specify next point or [Undo]: @0,30 
Specify next point or [Close/Undo]: 
 

Ayağın sağdaki sınır çizgisi için;  
 

Command: l 
LINE Specify first point: 70,-30 
Specify next point or [Undo]: @0,-90 
Specify next point or [Undo]: 
 

Karşıda görünen kayıt çizimi için;  
 

Command: l 
LINE Specify first point: 70,-100 
Specify next point or [Undo]: @80,0 
Specify next point or [Undo]: 
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Yukarıda yazılan komutlar girildiğinde şu şekilde bir görüntü ortaya çıkacaktır. 
 

 

Şekil 2.18: Detay resmin görünen yüzeylerinin çizimi  

Daha sonra görünmeyen yüzeyler kesik çizgiler ile çizilir. Bunun için katman 
ayarlarından yararlanınız.  
 

Ayağın köşe takozunu kestiği çizgiyi çizmek için;  
 
Command: l 
LINE Specify first point: 70,-30 
Specify next point or [Undo]: @0,30 
Specify next point or [Undo]: 
 

Ortadaki kayıtın ayağı kestiği çizgiyi çizmek için;  
 
Command: l 
LINE Specify first point: 56,-100 
Specify next point or [Undo]: @14,0 
Specify next point or [Undo]: 
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Hampaylı zıvanayı çizmek için; 
 
Command: l 
LINE Specify first point: 59,0 
Specify next point or [Undo]: @0,-12 
Specify next point or [Undo]: 
 
Command: l 
LINE Specify first point: 60,0 
Specify next point or [Undo]: @0,-12 
Specify next point or [Undo]: @-18,0 
Specify next point or [Close/Undo]: @0,-88 
Specify next point or [Close/Undo]: 
 
Command: l 
LINE Specify first point: 49,-12 
Specify next point or [Undo]: @0,-88 
Specify next point or [Undo]: 
 

Alttaki kesip yaklaştırma çizgisini çizmek için;  
 
Command: l 
LINE Specify first point: 25,-120 
Specify next point or [Undo]: @50,0 
Specify next point or [Undo]: 
 

Sağdaki kesip yaklaştırma çizgisini çizmek için;  
 
Command: l 
LINE Specify first point: 150,23 
Specify next point or [Undo]: @0,-128 
Specify next point or [Undo]: 
 

Komutları girilir. Yukarıdaki komutlar girildiğinde şu şekilde bir görüntü ortaya 
çıkacaktır. (Şekil 2.19) 
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Şekil 2.19: Görünmeyen çizgilerin kesik çizgi ile gösterilmesi  

Daha sonra blok olarak kaydedilmiş olan vida çizimi, işaret ve sembolleri yapılır.  
(Şekil 2.20) 
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Şekil 2.20: Vida çizimi, işaret ve sembolleri  

Son olarak ta zıvana çizimi ve gerekli taramalar hatch komutu yardımıyla yapılır.   
 
Command: l 
LINE Specify first point: 42,-12 
Specify next point or [Undo]: @7,-88 
Specify next point or [Undo]: 
 
Command: l 
LINE Specify first point: 49,-12 
Specify next point or [Undo]: @-7,-88 
Specify next point or [Undo]: 
 

Komutları girildiğinde zıvana işareti gösterilmiş olacaktır. Hatch komutu yardımıyla 
tarama işlemi yapılır. (Şekil 2.21) 
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Şekil 2.21: Sehpanın yan detayının çizilmesi 
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2.7. Montaj Resminin Çizimi 
 

Üç boyutlu çizilmiş sehpayı move komutuyla ayırmak suretiyle montaj resmi 
gösterilir. (Şekil 2.22) 

 

 

Şekil 2.21: Sehpanın montaj res minin çizilmesi 

 

 

 

 
 

 
 

 

 

B-B KESİTİ 
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UYGULAMA FAALİYETİ-2 
 

Köşe sehpası detay çizimi uygulaması yapınız.  
 

İşlem Basamakları Öneriler 

 Çizeceğiniz parçanın ölçülerine uygun  
gerekli limit ayarlarını yapınız.  

 Çiziminizde kullanacağınız katman 
ayarlarını yapınız.  

 Çiziminizi artışlı koordinat sistemine 
göre oluşturunuz.  

 Limiti A4 kağıt ebatı olan 210-297 
ölçülerinde ayarlayınız.  

 limits└ 
 0,0└  
 210,297└ 

 Çizeceğiniz detayın kesitini inceleyiniz.. 

 
 

 Verilen sehpa hampaylı zıvanalı 
birleştirilmiş olup üst tablanın 
bağlantısı köşe takozları yardımıyla 
sağlanmıştır. 

 Buna göre üst kesitte yer alan D 
detayını çizeceğiz. 

 Ayağı oluşturunuz. 

 

 Line 
 0,0 
 @40,0 
 @0,-12 
 @-10,0 
 @0,-7 
 @10,0 
 @0,-21 
 @-21,0 
 @0,10 
 @-7,0 
 @0,-10 
 @-12,0 
 @0,40 

UYGULAMA FAALİYETİ–2 
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 Sağdaki kaydı çiziniz.  

 
 

 Line 
 40,-7 
 @70,0 
 Line 
 40,-26 
 @70,0 
 Line 
 31,-12 
 @0,-7 

 Alttaki kaydı çiziniz. 

 

 Line 
 5,-40 
 @0,-70 
 Line 
 26,-40 
 @0,-70 
 Line 
 12,-31 
 @7,0 

 Zıvanayı çiziniz.  

 

 Katman ayarlarından kesik çizgiyi 
seçiniz. 

 Line 
 12,-30 
 @0,18 
 @18,0 
 Line 
 19,-30 
 @0,11 
 @11,0 
 Line 
 12,-12 
 @7,-7 
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 Köşe takozunu çiziniz.  

 

 
 Katman ayarlarından kalın çizgiyi 

seçiniz. 
 Line 
 26,-96 
 @20,20 
 @0,8 
 @8,0 
 @14,14 
 @0,8 
 @8,0 
 @20,20 
 

 Vida çizimlerini yapınız. 

 

 Daha önce block olarak kaydetmiş 
olduğunuz vida çizimini köşe takozu 
üzerinde yerleştiriniz.  

 

 Kesme işaretlerini koyarak çiziminizi 
sınırlandırınız.  

 

 Katman ayarlarından eksen çizgisini 
seçiniz. 

 Line 
 0,-110 
 @31,0 
 Line 
 110,0 
 @0,-31 
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 Gerekli taramaları yapınız.  

 

 Katman ayarlarından ince çizgiyi 
seçiniz. 

 Hatch komutunu kullanarak ayağı 
masif makta taraması ile tarayınız. 

 Sketch komutunu kullanarak elyaf 
taramalarını yapınız. 

 Gerekli işaret ve sembolleri yaparak işin 
adını yazınız.  

 

 İşin adını resmin altına yazınız ve yazı 
yazmak için text komutunu kullanınız. 

 Yazı karakterini Times New Roman 
ve yazı yüksekliğini 3 yaparak 
yazınız.  
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KONTROL LİSTESİ 
Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 
değerlendiriniz. 

 
 
 

 

 

 
Değerlendirme Ölçütleri Evet Hayır 

1. Çizeceğiniz parçanın ölçülerine uygun gerekli 
limit ayarlarını yaptınız mı? 

2. Çiziminizde kullanacağınız katman ayarlarını 
yaptınız mı?  

  

3. Çizeceğiniz detayın kesitini incelediniz mi?    
4. Ayağı oluşturdunuz mu?   
5. Sağdaki kayıtı çizdiniz mi?   
6. Alttaki kayıtı çizdiniz mi?   
7. Zıvanayı çizdiniz mi?   
8. Köşe takozunu çizdiniz mi?   
9. Vida çizimlerini yaptınız mı?   
10. Kesme işaretlerini koyarak çiziminizi 

sınırlandırdınız mı? 
  

11. Gerekli taramaları yaptınız mı?    
12. Gerekli işaret ve sembolleri yaparak işin adını 

yazdınız mı? 
  

 

 

 

DEĞERLENDİRME 
Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 
“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz.  
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız.  
 

 
1. (  ) Net resim çizimlerinde ön görünüş alın düzleme çizilmelidir.  
 
2. (  ) Net resim çizimlerinde ölçülendirme yapılmaz.  
 
3. (  ) Büyük boyutlu cisimlerin çizimlerinde küçültme ölçeği kullanılır.  
 
4. (  ) 2/1 ölçeği küçültme ölçeğidir.  
 
5. (  ) Text komutu yazı yazma komutudur. 
 
6. (  ) Hatch komutu tarama komutudur.  
 
7. (  ) Orjin noktasının değeri 0,0 dır.  
 
8. (  ) Yatay çizgilerin çizilmesinde X düzlemi değeri sağ tarafta (-) olarak girilir. 
 
9. (  ) Dikey çizgilerin çizilmesinde Y düzlemi değeri yukarı tarafta (+) olarak girilir.  
 
10. (  ) @0,40 yazıldığında yatay çizgi çizilir.  

 

 
 
 

 

 

DEĞERLENDİRME 
Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 
Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz.  

 

 

 

 

 
 

 

 

 

ÖĞRENME FAALİYETİ-3 
 

 

ÖLÇME VE DEĞERLENDİRME 
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Bu faaliyette verilen bilgiler doğrultusunda düzgün, ölçüsünde, kurallara uygun bir 

şekilde, ecza dolabı yapabileceksiniz. 
 

 

 
 

 

 Televizyon dolabının çiziminde kesit ve detaya neden ihtiyaç vardır? 

Araştırınız.  

 Çevrenizdeki iç mimarlarla bağlantıya geçerek tek mobilya çizimlerini 

inceleyiniz.  

 Not aldığınız fikir ve görüşleri arkadaşlarınızla paylaşınız.  

3. TELEVİZYON DOLABI ÇİZİMİ 
 

3.1. Üç Boyutlu Çizimi 
 

Çizime başlamadan aşağıda verilen televizyon dolabını inceleyiniz.  (Şekil 3.1) 

 

Şekil 3.1: Televizyon dolabı  izometrik pers pektifi 

 

AMAÇ 

ÖĞRENME FAALİYETİ–3 
 

ARAŞTIRMA 
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Çizime gövdeyi oluşturarak başlayabiliriz. 
 

Üst tablayı çizmek için; 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 0,0,0 
Specify corner or [Cube/Length]: l 
Specify length: 84 
Specify width: 47 
Specify height: 2 
Komutları girilir.  
 

Soldaki tablayı çizmek için;  
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 1,47,0 
Specify corner or [Cube/Length]: l 
Specify length: 2 
Specify width: -40 
Specify height: -85 
 

Komutları girilir.  
 

Sağdaki tablayı çizmek için;  
 

Command: box 
Specify corner of box or [CEnter] <0,0,0>: 83,47,0 
Specify corner or [Cube/Length]: l 
Specify length: -2 
Specify width: -40 
Specify height: -85 
Komutları girilir.  
 

Alttaki tablayı çizmek için;  
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 3,7,-77 
Specify corner or [Cube/Length]: l 
Specify length: 78 
Specify width: 40 
Specify height: 2 
Komutları girilir.  
 

Bazayı çizmek için; 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 3,7.5,-77 
Specify corner or [Cube/Length]: l 
Specify length: 78 
Specify width: 2 
Specify height: -7.5 
Komutları girilir.  
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Yukarıda yazılan komutlar girildiğinde alttaki görüntü ortaya çıkacaktır. (Şekil 3.2) 
 

 

Şekil 3.2: Üç boyutlu gövdenin oluşturulması 

Kapaklar şu şekilde çizilir. 
 

Soldaki kapağı çizmek iç in; 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 1,7,0 
Specify corner or [Cube/Length]: l 
Specify length: 41 
Specify width: -2 
Specify height: -77 
 

Komutları girilir.  
 

Sağdaki kapağı çizmek için; 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 42,7,0 
Specify corner or [Cube/Length]: l 
Specify length: 41 
Specify width: -2 
Specify height: -77 
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Komutları girilir.  
Yukarıda yazılan komutlar girildiğinde alttaki görüntü ortaya çıkacaktır. (Şekil 3.3) 

 

Şekil 3.3: Üç boyutlu kapakların çizimi 

Kulplar şu şekilde çizilir. 
 

Soldaki kulbu oluşturmak için; 
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 40,5,-3 
Specify corner or [Cube/Length]: l 
Specify length: -2 
Specify width: -2 
Specify height: -10 
Komutları girilir.  
 

Sağdaki kulbu oluşturmak için;  
Command: box 
Specify corner of box or [CEnter] <0,0,0>: 44,5,-3 
Specify corner or [Cube/Length]: l 
Specify length: 2 
Specify width: -2 
Specify height: -10 
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Komutları girilir.  
Yukarıda yazılan komutlar girildiğinde alttaki görüntü ortaya çıkacaktır. (Şekil 3.4) 

 

Şekil 3.4: Üç boyutlu kulpların çizimi  
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3.2. Net Resim Çizimi 
 

Televizyon dolabının çiziminde kutupsal koordinat sistemi ele alınacaktır. İlk olarak 
kutupsal koordinat sistemine göre ön görünüşü oluşturalım. 
 

Üst tablayı çizmek için; 
Command: l 
LINE Specify first point: 0,0 
Specify next point or [Undo]: @84<0 
Specify next point or [Undo]: @2<270 
Specify next point or [Close/Undo]: @84<180 
Specify next point or [Close/Undo]: @2<90 
Specify next point or [Close/Undo]: 

Komutları girilir.  
 

Gövdeyi oluşturmak için;  
Command: l 
LINE Specify first point: 1,-2 
Specify next point or [Undo]: @85<270 
Specify next point or [Undo]: @82<0 
Specify next point or [Close/Undo]: @85<90 
Specify next point or [Close/Undo]: 

Komutları girilir.  
 

Bazayı çizmek için; 
Command: l 
LINE Specify first point: 1,-79 
Specify next point or [Undo]: @82<0 
Specify next point or [Undo]: 
Komutları girilir.  
 

Kapağı çizmek için; 
Command: l 
LINE Specify first point: 42,-2 
Specify next point or [Undo]: @77<270 
Specify next point or [Undo]: 

Komutları girilir.  
 

Baza kısmında görünen dikmelerin çizimi için; 
Command: l 
LINE Specify first point: 3,-87 
Specify next point or [Undo]: @8<90 
Specify next point or [Undo]: 
 

Command: l 
LINE Specify first point: 81,-87 
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Specify next point or [Undo]: @8<90 
Specify next point or [Undo]: 

Komutları girilir.  
Kulpları çizmek için rectangle (dikdörtgen çizme) komutundan faydalanılır.  

 
Soldaki kulbu çizmek için;  

Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 40,-6 
Specify other corner point or [Dimensions]: @-2,-10 

Komutları girilir.  
 

Sağdaki kulbu çizmek için;  
Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 44,-6 
Specify other corner point or [Dimensions]: @2,-10 

Komutları girilir.  
 

Yukarıda yazılan komutlar girildiğinde alttaki görüntü ortaya çıkacaktır. (Şekil 3.5) 
 

 

Şekil 3.5: Ön görünüşün çizilmesi 

Yan görünüş ön görünüşün sağ tarafında oluşturulur.  
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Üst tablayı çizmek için; 
 

Command: l 
LINE Specify first point: 114,0 
Specify next point or [Undo]: @47<0 
Specify next point or [Undo]: @2<270 
Specify next point or [Close/Undo]: @47<180 
Specify next point or [Close/Undo]: 

Komutları girilir.  
 

Yan tablayı çizmek için; 
Command: l 
LINE Specify first point: 114,0 
Specify next point or [Undo]: @87<270 
Specify next point or [Undo]: @40<0 
Specify next point or [Close/Undo]: @85<90 
Specify next point or [Close/Undo]: 

Komutları girilir.  
 
Kapağı çizmek için; 

Command: l 
LINE Specify first point: 156,-2 
Specify next point or [Undo]: @77<270 
Specify next point or [Undo]: @2<180 
Specify next point or [Close/Undo]: 

Komutları girilir.  
 

Kulpu çizmek için; 
Command: l 
LINE Specify first point: 156,-6 
Specify next point or [Undo]: @2<0 
Specify next point or [Undo]: @10<270 
Specify next point or [Close/Undo]: @2<180 
Specify next point or [Close/Undo]: 

Komutları girilir.  
 

Yukarıda yazılan komutlar girildiğinde alttaki görüntü ortaya çıkacaktır. (Şekil 3.6) 
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Şekil 3.6: Yan görünüşün çizilmesi 

Daha sonra üst görünüş ön görünüşün altına çizilir. Üst tablanın çiziminde rectangle 
komutundan faydalanılır. 
 

Üst tablayı çizmek için; 
 

Command: _rectang 
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 0,-117 
Specify other corner point or [Dimensions]: @84,-47 
 

Komutları girilir.  
 

Yukarıda yazılan komutlar girildiğinde alttaki görüntü ortaya çıkacaktır. (Şekil 3.7) 
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Şekil 3.7: Üst görünüşün çizilmesi 
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3.3. Ölçülendirme 
 

Gerekli katman ayarları yapılır. Daha sonra istenirse üst menülerde yer alan 
dimension>Linear dimension seçeneği ile ölçülendirme yapılabilir. (Şekil 3.8) 

 

Şekil 3.8: Televizyon dolabının ölçülendirilmesi 
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3.4. Renklendirme ve Desen  
 

Renklendirme için üst menüden Draw>Hatch seçimi yapılır. Buradan gradient seçilir. 
Şekil istenen renkle boyanır. (Şekil 3.9) 

 

Şekil 3.9: Televizyon dolabının renklendirilmesi 

Daha sonra tarama işlemine geçilir. (Şekil 3.10) 
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Şekil 3.10: Televizyon dolabının renklendirilmesi ve desenlendirilmesi  
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3.5. Kesit Yerlerinin Belirlenmesi ve Çizimi  
 

Gerekli katman ayarları yapıldıktan sonra net resim üzerinden kesit yeri gösterilir.  
 

Command: l 
LINE Specify first point: 50,5 
Specify next point or [Undo]: @97<270 
Specify next point or [Undo]: 
 

Daha sonra yan görünüşün sağ yanına yan kesit çizimi yapılır.  
Üst tablayı çizmek için; 

Command: l 
LINE Specify first point: 170,0 
Specify next point or [Undo]: @47<0 
Specify next point or [Undo]: @2<270 
Specify next point or [Close/Undo]: @47<180 
Specify next point or [Close/Undo]: 
 

Yan tablayı çizmek için; 
Command: l 
LINE Specify first point: 170,0 
Specify next point or [Undo]: @87<270 
Specify next point or [Undo]: @40<0 
Specify next point or [Close/Undo]: @85<90 
Specify next point or [Close/Undo]: 
 

Kapağı çizmek için; 
Command: l 
LINE Specify first point: 212,-2 
Specify next point or [Undo]: @77<270 
Specify next point or [Undo]: @2<180 
Specify next point or [Close/Undo]: 
 

Alt tablayı çizmek için; 
Command: l 
LINE Specify first point: 170,-79 
Specify next point or [Undo]: @40<0 
Specify next point or [Undo]: 
LINE Specify first point: 170,-77 
Specify next point or [Undo]: @40<0 
Specify next point or [Undo]: 
 

Bazayı çizmek için; 
Command: l 
LINE Specify first point: 208,-87 
Specify next point or [Undo]: @8<90 
Specify next point or [Undo]: 
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Üstteki tas menteşeyi çizmek için; 
 

Command: l 
LINE Specify first point: 210,-14 
Specify next point or [Undo]: @1.2<180 
Specify next point or [Undo]: @1.5<90 
Specify next point or [Close/Undo]: @1.5<180 
Specify next point or [Close/Undo]: @1.5<270 
Specify next point or [Close/Undo]: @3.7<180 
Specify next point or [Close/Undo]: @1.5<270 
Specify next point or [Close/Undo]: @3.7<0 
Specify next point or [Close/Undo]: @1.5<270 
Specify next point or [Close/Undo]: @1.5<0 
Specify next point or [Close/Undo]: @1.5<90 
Specify next point or [Close/Undo]: @1.2<0 
Specify next point or [Close/Undo]: 
 

Alttaki tas menteşe alt kısma kopyalanıp yapıştırılır. Bunun için; 
Command: _copy 
Select objects: 200,-10 
Specify opposite corner: 210,-20 
11 found 
Select objects: 
Specify base point or displacement, or [Multiple]: 0,0 
Specify second point of displacement or <use first point as displacement>: 0,-49.5 
 

Son olarak tarama yapılır ve işin adı yazılır. (Şekil 3.11) 
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Şekil 3.11: Televizyon dolabının yan kesitinin çizilmesi 
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3.6. Detay Yerlerinin Belirlenmesi ve Çizimi  
 

İlk olarak kesit üzerinden detay yeri belirtilir. Bunun için gerekli katman ayarları 
yapıldıktan sonra; 

 
Command: circle 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 207,-74 
Specify radius of circle or [Diameter] <15.0000>: 15 
 

Komutları girilir. Detayın adı ve işin adı yazılarak detay yeri gösterilir. (Şekil 3.12) 

 

Şekil 3.12: Kesit üzerinden detay yerinin gösterilmesi 

Kesit üzerinden gösterilen detay yerine göre detay resmi çizilir.  
 

Çizime alt tabla çizilerek başlanır. Alt tablayı çizmek için; 
 

Command: l 
LINE Specify first point: 0,0 
Specify next point or [Undo]: @120<0 
Specify next point or [Undo]: @20<270 
Specify next point or [Close/Undo]: @120<180 
Specify next point or [Close/Undo]: 
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Bazayı çizmek için; 
Command: l 
LINE Specify first point: 115,-20 
Specify next point or [Undo]: @75<270 
Specify next point or [Undo]: @20<180 
Specify next point or [Close/Undo]: @75<90 
Specify next point or [Close/Undo]: 
 

Kapağı çizmek için; 
Command: l 
LINE Specify first point: 120,-20 
Specify next point or [Undo]: @20<0 
Specify next point or [Undo]: @170<90 
Specify next point or [Close/Undo]: 
 

Command: l 
LINE Specify first point: 120,0 
Specify next point or [Undo]: @150<90 
Specify next point or [Undo]: 
 

Dolap-kapak bağlantısı düz tas menteşeli olarak gösterilir. Daha önce yapılmış block 
seçeneğinden yararlanılır.  
 

Katman ayarlarından kesik çizgi seçimi yapılır. Alt tabla-yan tabla bağlantısı kavelalı 
olarak gösterilir. Bunun için; 
Command: circle 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 80,-10 
Specify radius of circle or [Diameter] <4.0000>: 5 
Command: 
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 80,-10 
Specify radius of circle or [Diameter] <5.0000>: 4 
 

Baza ile alt tabla bağlantısı kavelalı olarak çizilir. Daha önce yapılmış block 
seçeneğinden yararlanılır.  
 

Katman ayarlarından eksen çizgisi seçimi yapılır. Daha sonra kesip yaklaştırma işareti 
çizilir.  
 

Command: l 
LINE Specify first point: 145,150 
Specify next point or [Undo]: @145<180 
Specify next point or [Undo]: @255<270 
Specify next point or [Close/Undo]: 
 

Gerekli tarama işlemleri yapılır. İşin adı yazılarak çizim bitirilir. (Şekil 3.13). 
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Şekil 3.13: Detay resminin çizilmesi 
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3.7. Montaj Resminin Çizimi 
 

Üç boyutlu çizilmiş televizyon dolabını move komutuyla ayırmak suretiyle montaj 
resmi gösterilir. (Şekil 3.14) 

 

Şekil 3.14: Televizyon dolabı montaj res minin çizilmesi 
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UYGULAMA FAALİYETİ-3 
 

Televizyon Dolabı Üç Boyutlu Çizimi Uygulaması Yapınız. 
 

İşlem Basamakları Öneriler 

 Çiziminizde kullanacağınız katman 
ayarlarını yapınız.  

 Çiziminizi görünüm komutlarından 
SW isometric modunda oluşturunuz. 

 Anlam karmaşıklığına yol açmamak 
için görünmeyen çizgileri hidden 
komutunu kullanarak gizleyiniz. 

 Gerekli katman ayarlamalarını 
yapınız.  

 Çizeceğiniz TV dolabını inceleyiniz.  

 

 TV dolabı genişliği 138 cm, 
yüksekliği 58cm, derinliği 45 cm`dir. 

 Tablaların birbiriyle bağlantısı 
kavelalı olarak yapılmıştır.  

 Kapaklar tas menteşeli olarak 
bağlanmıştır.  

 Çekmece, çekmece rayı üzerinde 
hareket etmektedir. 

 Üst tablayı çiziniz. 

 
 

 Katman ayarlarından kalın çizgiyi 
seçiniz. 

 Box 
 0,0,0 
 L 
 138 
 -45 
 -2 

UYGULAMA FAALİYETİ–3 



 

  98 

 Soldaki yan tablayı çiziniz.  

 
 

 Box 
 0,0,-2 
 L 
 2 
 -45 
 -44 

 Sağdaki yan tablayı çiziniz. 

 

 Box 
 138,0,-2 
 L 
 -2 
 -44 
 -44 

 Alt tablayı çiziniz.  

 

 Box 
 0,0,-46 
 L 
 138 
 -45 
 -2  
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 İçteki dikmeleri çiziniz.  

 

 Box 
 42,0,-2 
 L 
 2 
 -45 
 -44 
 Box 
 94,0,-2 
 L 
 2 
 -45 
 -44 

 Ortadaki raf parçasını çiziniz. 

 

 Box 
 44,0,-30 
 L 
 50 
 -45 
 2 

 Kapakları çiziniz. 

 

 Box 
 2,-44.5,-2 
 L 
 40 
 2 
 -44 
 Box 
 136,-44.5,-2 
 L 
 -40 
 2 
 -44 
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 Çekmeceyi çiziniz. 

 

 Box 
 44,-44.5,-30 
 L 
 50 
 2 
 -16 

 Kapaktaki kulpları çiziniz.  

 
 

 Box 
 40,-44.5,-4 
 L 
 -2 
 -2 
 -10 
 Box 
 98,-44.5,-4 
 L 
 2 
 -2 
 -10 

 Çekmecedeki kulbu çiziniz. 

 

 Box 
 64,-44.5,-37 
 L 
 10 
 -2 
 -2 
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 Ayakları çiziniz.  

 

 Cylinder 
 7,-5,-48 
 3 
 -10 
 Cylinder 
 7,-40,-48 
 3 
 -10 
 Cylinder 
 131,-5,-48 
 3 
 -10 
 Cylinder 
 131,-40,-48 
 3 
 -10 

 

KONTROL LİSTESİ 
Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 
değerlendiriniz. 
 

Değerlendirme Ölçütleri Evet Hayır 
1. Çiziminizde kullanacağınız katman ayarlarını 

yaptınız mı?  
  

2. Çizeceğiniz TV dolabını incelediniz mi?   
3. Üst tablayı çizdiniz mi?   
4. Soldaki yan tablayı çizdiniz mi?   
5. Sağdaki yan tablayı çizdiniz mi?   
6. Alt tablayı çizdiniz mi?   
7. İçteki dikmeleri çizdiniz mi?   
8. Ortadaki raf parçasını çizdiniz mi?   
9. Kapakları çizdiniz mi?   
10. Çekmeceyi çizdiniz mi?   
11. Kapaktaki kulpları çizdiniz mi?   
12. Çekmecedeki kulbu çizdiniz mi?   
13. Ayakları çizdiniz mi?   
 

DEĞERLENDİRME 
Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 
“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz.  
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ÖLÇME VE DEĞERLENDİRME 
 

VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız.  
 

 
1. (   ) Bir cismin görünmez yüzeylerini görünür hale getirmek için kesit alınır.  

 
2. (   ) Detaylar aksi belirtilmediği sürece 1/1 ölçekle çizilirler. 

 
3. (   ) Üç boyutlu çizimlerde X, Y, Z değerleri mutlaka yazılmalıdır.  

 
4. (   ) Net resim üzerinde kesit yerlerinin belirtilmesine gerek yoktur. 

 
5. (   ) Hidden görünmeyen çizgilerin gizlenmesinde kullanılır.  

 
6. (   ) Box komutu ile silindir çizimi yapılır.  

 
7. (   ) Move komutu taşımak komutudur.  

 
8. (   ) Serbest çizgi komutu stretch komutudur. 

 
9. (   ) Line seçimi yapıldığında @20, 0 değeri girildiğinde yukarı doğru 20 mm 

uzunluğunda çizgi çizilir.  
 
10. (   ) Ölçülendirme ayarları Dimension Style Manager diyalog kutusundan yapılır.  
 
 

 

DEĞERLENDİRME 
Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 
Cevaplarınızın tümü doğru ise “Modül Değerlendirme”ye geçiniz. 

 
 
 

 

 

 

 

 
 

 

 

ÖLÇME VE DEĞERLENDİRME 
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MODÜL DEĞERLENDİRME 
KONTROL LİSTESİ 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 
evet, kazanamadığınız beceriler için hayır kutucuğuna  (x) işareti koyarak kendinizi 
değerlendiriniz. 

 
Değerlendirme Ölçütleri Evet Hayır 

Resim Çerçevesi Çizimi İle İlgili Ölçütler 
  

1 

Çizeceğiniz parçanın ölçülerine uygun gerekli limit ayarlarını 
yaptınız mı?  
Çiziminizde kullanacağınız katman ayarlarını yaptınız mı? 

  

2 Çizeceğiniz resim çerçevesini incelediniz mi?  
  

3 Resim çerçevesi ön görünüşü sınırlarını çizdiniz mi?  
  

4 Çerçeve iç parçasını çizdiniz mi?   

5 Çerçeveleri 45º gönyeburun çizdiniz mi? 
  

6 Yan görünüşü çizdiniz mi?  
  

7 Üst görünüşü çizdiniz mi? 
  

8 Gerekli ölçülendirmeleri yaptınız mı? 
  

9 İşin adını ve ölçeğini yazdınız mı?  
  

Köşe Sehpası Çizimi İle İlgili Ölçütler 
  

1 

Çizeceğiniz parçanın ölçülerine uygun gerekli limit ayarlarını 
yaptınız mı?  
Çiziminizde kullanacağınız katman ayarlarını yaptınız mı? 

  

2 Çizeceğiniz detayın kesitini incelediniz mi? 
  

3 Ayağı oluşturdunuz mu? 
  

4 Sağdaki kayıtı çizdiniz mi? 
  

5 Alttaki kayıtı çizdiniz mi? 
  

6 Zıvanayı çizdiniz mi? 
  

7 Köşe takozunu çizdiniz mi? 
  

8 Vida çizimlerini yaptınız mı? 
  

9 Kesme işaretlerini koyarak çiziminizi sınırlandırdınız mı? 
  

10 Gerekli taramaları yaptınız mı?  
  

11 Gerekli işaret ve sembolleri yaparak işin adını yazdınız mı?  
  

MODÜL DEĞERLENDİRME 
 



 

  104 

Televizyon Dolabı Çizimi İle İlgili Ölçütler 
  

1 Çiziminizde kullanacağınız katman ayarlarını yaptınız mı? 
  

2 Çizeceğiniz TV dolabını incelediniz mi? 
  

3 Üst tablayı çizdiniz mi? 
  

4 Soldaki yan tablayı çizdiniz mi? 
  

5 Sağdaki yan tablayı çizdiniz mi? 
  

6 Alt tablayı çizdiniz mi? 
  

7 İçteki dikmeleri çizdiniz mi? 
  

8 Ortadaki raf parçasını çizdiniz mi? 
  

9 Kapakları çizdiniz mi? 
  

10 Çekmeceyi çizdiniz mi? 
  

11 Kapaktaki kulpları çizdiniz mi? 
  

12 Çekmecedeki kulbu çizdiniz mi? 
  

13 Ayakları çizdiniz mi? 
  

 

DEĞERLENDİRME 
Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 
“Evet” ise bir sonraki modüle geçmek için öğretmeninize başvurunuz.  
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CEVAP ANAHTARLARI 
ÖĞRENME FAALİYETİ 1 CEVAP ANAHTARI 

 

SORULAR CEVAPLAR 

1 Doğru 

2 Yanlış  

3 Yanlış  

4 Doğru 

5 Doğru 

6 Yanlış  

7 Doğru 

8 Yanlış  

9 Doğru 

10 Yanlış  

 

ÖĞRENME FAALİYETİ 2 CEVAP ANAHTARI 
SORULAR CEVAPLAR 

1 Doğru 

2 Yanlış  

3 Doğru 

4 Yanlış  

5 Doğru 

6 Doğru 

7 Doğru 

8 Yanlış  

9 Doğru 

10 Yanlış  

ÖĞRENME FAALİYETİ 3 CEVAP ANAHTARI 
 

SORULAR CEVAPLAR 

1 Doğru 

2 Yanlış  

3 Doğru 

4 Yanlış  

5 Doğru 

6 Doğru 

7 Doğru 

8 Yanlış  

9 Doğru 

10 Yanlış  

 

CEVAP ANAHTARLARI 
 


